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1.  INTRODUCTION
Thank you for choosing Em50® series data loggers from METER Group. 

The Em50 series loggers (Em50, Em50R, and Em50G) are part of the ECH20 System, a 
collection of data loggers, software, and compatible sensors to measure soil moisture and 
other environmental parameters accurately and cost effectively.

The Em50 series includes three models: 
•	Em50 is a manual-download logger.

•	Em50R is a a remote-download logger that communicates through a radio module. 

•	Em50G is a remote-download logger that communicates through a cellular module to 
transmit data over the internet. 

Throughout this manual, references to Em50 apply to all versions of the logger unless 
otherwise specified. 

Verify all instrument components are included and appear in good condition:
•	Em50 series logger with five batteries

•	Micro-USB communications cable

•	Zip ties for mounting the logger

•	USB drive containing ECH20 Utility software installer

•	Antenna (Em50R and Em50G)

•	Device subscription card (Em50G) 
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2.  ABOUT THE EM50 LOGGER SERIES

2.1  EM50 LOGGER SERIES OVERVIEW
The ECH2O system is made of data loggers, sensors, telemetry, and software that help you 
measure soil moisture and other environmental parameters accurately and cost effectively. 
METER's innovative sensors are the heart of the system and we designed it to be very easy to 
use (no programming needed).

The Em50 series loggers are 5-port, self-contained data loggers especially suited for 
field research and commercial agriculture. The Em50 logger series includes three models: 
the Em50, the Em50R, and the Em50G. These devices are housed in a weather-resistant 
enclosure, making them suitable for long-term outdoor operation.

Em50:  The Em50 is the basic logger. The communication with this model is through a stereo 
to USB or stereo to serial cable to a PC or mobile handheld device. An integrated solar panel 
is an options for the Em50.

Em50R:  The Em50R includes a spread-spectrum radio telemetry module that delivers data 
to a DataStation. The radio module is available in long-range 900 MHz. Use the telemetry in 
energy efficient transmit mode or two-way mode. (Section 6 provides more information on 
telemetry.)

Em50G:  The Em50G includes a GSM/GPRS (Global System for Mobile communications/
General Packet Radio Service) cellular module to allow environmental measurement data 
transmission over the Internet. METER partners with a provider of global cellular data 
service to make data transmission and maintenance easy and inexpensive. Measurements 
from the Em50G are sent wirelessly to METER's internet server and are available for 
download using DataTrac 3 software or the Em50G WebViewer. An integrated solar panel is 
an option for the Em50G.

Em50 Compatible Sensors:  You can use the Em50 to log data for almost all of the legacy 
sensors that METER sell. Please see our website (metergroup.com) or our catalog for an 
up-to-date list of supported sensors.

2.2  SPECIFICATIONS

Sensor Input Ports 5, 12-bit analog, or 32-bit digital

Sensor Port Type 3.5-mm stereo plug connector

Data Storage 1 MB (36,800 scans for all five ports)

Memory Type Nonvolatile flash

Battery Capacity Five AA alkaline or lithium batteries

http://www.metergroup.com
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Computer Communication
Dedicated serial port 3.5-mm stereo plug connector for use 
with the METER USB cable adapter (UCA)

Radio (Em50R) 900 MHz or 2.4 GHz (discontinued)

Cellular (Em50G)
GSM/GPRS cellular technology. Cellular service and data 
hosting service provided by METER

Enclosure Weather-, impact-, and UV-resistant polymer

Enclosure Rating IP55, NEMA 3R

Operating Environment –40 to +60 °C (0% to 100% relative humidity)

Compliance
Manufactured under ISO 9001:2015

EM ISO/IEC 17050:2010 (CE Mark)

2.3  FUNCTIONALITY

2.3.1  RESET BUTTON
All Em50 logger types have a "Reset" button. If your logger does not respond to connection 
attempts or does not appear to be working, press the reset button. This reboots the logger 
and the Status light turns on momentarily. The internal data storage of the logger is 
nonvolatile so you do not lose data or settings if you press the reset button.

2.3.2  EM50 SERIES STATUS LIGHTS
The green and red lights indicate the current status of your Em50/Em50G logger and the 
logger self test function. A short, single blink of the green light every 5 s indicates the 
Em50/Em50R/Em50G is configured to log sensor data. The light does not blink if the logger 
measurement interval is set to 0 or "Off."

The green light blinks slowly on and off to indicate the logger is connected to a serial port 
or the cellular module is powered on. The green light pulses when the Em50G is actively 
sending data over the cellular network.

The red light blinks continuously to indicate the logger date and time are not set correctly. 
This can happen when the batteries have been disconnected. You must connect to your 
Em50 series logger using any ECH2O System software to reset the logger internal clock. The 
logger stops error blinking when the date is reset or after 2 min have elapsed (to preserve 
battery power).
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2.3.3  EM50 SERIES TEST BUTTON
The Em50 series loggers have a "Test" button to perform basic functionality testing. When 
you press the Test button, the logger performs several checks on internal systems and with 
the Em50G attempts a communication session over the cellular network. The logger uses the 
lights during the test to indicate connection status.

Pressing the Test button may also reset the logger clock by using the time of the cellular 
network if the connected network supports time information.

Both the green and red lights blink slowly while the Em50G performs tests. Please be 
patient. It can take as much as 60 s or more to finish the cellular communication tests in 
the Em50G. 

A solid green light indicates that internal tests passed and there is successful 
communication over the cellular network to the METER Data Service. The Em50G leaves 
the light on for approximately 20 s. A solid red light indicates an error in the logger or in 
communicating to the METER Data Service. Please use the Communication Test feature in 
ECH2O® Utility to find the specific error.

2.4  SOFTWARE
The Em50 series gives you three software options for working with your hardware and 
collected data. Choose one or all to fit your needs. Download the latest versions of these 
programs at metergroup.com.

NOTE:  See Section 4 for a detailed breakdown of available software for the Em50 series loggers.

ECH2O Utility:  We included the ECH20 Utility software with your purchase. It provides a 
simple way to connect to and configure your loggers. The ECH2O Utility makes downloading 
and processing your data fast and easy.
•	Connect to Em50 loggers directly.

•	Set all logger configuration parameters.

•	Make real-time sensor measurements (scan sensors).

•	Create Microsoft® Excel® or text files with raw or processed data.

•	Create configuration and data files for use with DataTrac 3.

DataTrac 3:  DataTrac 3 is the premiere Em50 series system software designed to help you 
organize and visualize your measurement data. DataTrac 3 transforms endless columns 
and rows of raw data into meaningful, easily-interpreted graphs. DataTrac 3 comes 
with the Em50 system as a 30-day trial version. If you would like to continue to use 
DataTrac 3, contact METER to purchase a DataTrac 3 registration code. DataTrac 3 provides 
several features.
•	Explore trends and relationships in real time using powerful charting engines.

•	Database and organize data from multiple Em50 series loggers. 

http://www.metergroup.com
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•	Growing Tools combine data streams and track meaningful indicators. For example, plot 
vapor pressure deficit instead of just temperature and humidity. Or track growing degree 
days, plant available water, pore water EC, etc.

•	Use the virtual sensor tool to add desired information. For example, you can measure 
precipitation on just one logger and make that data stream a virtual sensor on every logger 
at that site.

•	Automatically collect data from your Em50G and Em50R loggers. All data—including 
manually collected data—is automatically organized and added to files chronologically.

•	Add notes and ideas to the data stream. Comments and reminders can help you make 
sense of a growing season worth of data later.

•	Educate and inform your team efficiently. The DataTrac 3 graphics reduce the time and 
expertise needed to understand soil moisture data.

Em50G Webviewer:  The Em50G WebViewer is a free web-based application that allows 
you to remotely download spreadsheets and view weekly graphs of your data without a 
DataTrac 3 license. See Section 4 for more information on the Em50G WebViewer.

NOTE:  Em50 loggers cannot be configured with WebViewer, please see Section 4 for logger configuration information.

2.4.1  EM50 SERIES DATA LOGGING SCHEME
The Em50 does not make sensor measurements until you set a measurement interval. You 
also need to configure the Em50 ports with the type of sensor plugged into each port. You 
can set these values using either ECH2O Utility or DataTrac 3.

2.4.2  EM50 MEASUREMENT INTERVAL
The measurement interval controls how often the Em50 records data to internal data 
storage. The interval you choose applies to all five ports on the Em50. So, it is impossible to 
have one port measuring sensors more or less frequently than another port.

The measurement interval works relative to the Em50 internal real-time, 24-h clock. For 
example, if you choose a measurement interval of 120 min, the Em50 stores data every 
2 h, on the hour. The resulting data shows sensor measurements hourly at 12:00 a.m., 
2:00 a.m.,..., 10:00 p.m. Choosing a measurement interval greater than 720 results in one 
set of data stored per day. For most applications, a measurement interval of 60 or 120 min is 
appropriate.

NOTE:   Setting the Em50 measurement interval to zero turns off sensor measurement and data storage.

For most sensor types, the Em50 makes a measurement from each of the five sensor ports 
every 60 s, regardless of the measurement interval value. When the Em50 internal clock 
reaches the user-programmed measurement interval, the Em50 stores the average of all 
the 60-s sensor readings taken since the last storage interval. Therefore, if you set the 
measurement interval to 60, the Em50 stores an average of the past 60 sensor readings. 
If you choose an interval of 1,440, the Em50 stores one value that represents the average 
sensor value for the entire 24-h period.
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NOTE:   The Em50G supports 5 min as the minimum value for the measurement interval setting.

2.5  HOW THE EM50 STORES DATA

2.5.1  DATA STORAGE FORMAT
 The Em50 stores raw data for each sensor. The stored values are not in millivolt units. Please 
review your individual sensors operators manual or visit our website (metergroup.com) for up 
to date equations to convert raw data to meaningful sensor values.

The Em50 stores data for all five sensor ports for each measurement interval. If no sensor 
is connected to one or more of the logger ports, the Em50 stores a "0" for that port. The 
Em50 data memory is nonvolatile flash. Removing the batteries or performing a system reset 
does not erase your data. 

Removing batteries or resetting the system also resets the clock in the data logger. To set 
the clock to the correct time, simply connect your Em50 to a computer or handheld device 
running ECH2O software.

2.5.2  DATA STORAGE SIZE
The Em50 stores more than 36,800 data scans. When the logger has filled its data memory, it 
begins overwriting the oldest data in the memory.

2.5.3  MEASUREMENT SPAN
Depending on the set measurement interval, the Em50 can read for several weeks to several 
years before its memory has filled. When you set up your Em50 using ECH20 Utility, the 
software displays how many days of data the Em50 can hold based on the measurement 
interval that you have chosen. You can determine how many days of data your Em50 can hold 
by dividing the size of the data memory (36,864 scans) by the measurement interval. For 
example, an Em50 set on an hourly measurement interval stores 1,500 days, or about 4 years, 
worth of data. An Em50 set to 5 min stores data for 125 days, or about 4 months.

2.5.4  COMPATIBLE SENSORS
The Em50 logger is only compatible with sensors made by METER. Here is a list of 
compatible sensors. To learn more about individual sensors and their respective calibrations, 
please visit metergroup.com.

Soil Water Content Sensors
10HS, EC-5, GS1 High Frequency Soil Moisture
5TM Soil Moisture and Soil Temperature
5TE, GS3 Soil Moisture, Soil Temperature, Soil EC
TEROS 12 Soil Moisture, Soil Temperature, and Electrical Conductivity

http://www.metergroup.com
http://www.metergroup.com
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Soil Water Potential Sensor
MPS-2, MPS-6 Water Potential and Temperature Sensor
TEROS 21 Water Potential and Temperature Sensor

Leaf Wetness Sensor
LWS Leaf Wetness Sensor

Temperature Sensors
ECT Air Temperature Sensor
RT-1 Rugged Soil Temperature Sensor

Rain Gauges Sensors
ECRN-50 Low Resolution Rain Gauge
ECRN-100 High Resolution Rain Gauge

Electrical Conductivity
ES-2, ES2F Electrical Conductivity and Temperature Sensors

Spectral Reflectance Indices
NDVI-hemi Spectral Reflectance Sensor
NDVI-field stop Spectral Reflectance Sensor
PRI-hemi Spectral Reflectance Sensor
PRI-field stop Spectral Reflectance Sensor

Temperature and Relative Humidity Sensor
EHT Temperature/RH Sensor
VP3 Temperature/RH Sensor

Radiation Sensors
PYR Solar Radiation Sensor
QSO-S PAR Photon Flux Sensor

Wind Sensors
Davis Cup Anemometer
DS-2 Sonic Anemometer
ATMOS 22 Ultrasonic Anemometer

NOTE:   The DS-2 Sonic Anemometer only works with those Em50 Series loggers manufactured after January 1, 2013.

Deep Drainage Sensors
G1/G2 Drain Gauge
G3 Drain Gauge

Irrigation Switch
PS-1 Pressure Switch
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Water Level Sensors
CTD-5, Water Level, Temperature, Electrical Conductivity
CTD-10, Water Level, Temperature, Electrical Conductivity
CTD, Water Level, Temperature, Electrical Conductivity

Miscellaneous Sensors
ECRN-50 Volume
Millivolt (0 to 3,000 mV input)
Millivolt (0 to 1,500 mV input)
Pulse Counter
Flow Meter

Discontinued Sensors
EC-10, EC-20 Classic Soil Moisture
EC-TM Soil Moisture and Temperature
ECH2O-TE Soil Moisture, Soil Temperature, Soil EC
MPS-1 Dielectric Water Potential Sensor
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3.  SETUP AND INSTALLATION
Remember, the 1-year service plan for the Em50G activates when METER ships the 
instrument and not at the time of installation.

3.1  INSTALLING THE BATTERIES
With the exception of the solar-powered Em50 and Em50G, all Em50 series loggers ship 
with a new set of AA alkaline batteries. Open the case and install the batteries in the proper 
orientation as indicated in the battery locations (Figure 1). After installing the batteries, 
press the silver Reset button located directly above the batteries.

Figure 1  Batteries and indicators

NOTE:  Em50/50G solar data loggers come with batteries installed. Remove battery pull-tab to activate batteries.

NOTE:  Use only NiMH (Nickel-Metal Hydride) batteries with the Em50/50G solar data loggers.

NOTE:  Installing or changing the batteries in your Em50 resets the internal real-time clock. You must connect to your 
Em50 using any ECH2O System software to reset the logger clock. If you do not set the logger clock, the time and date 
associated with each measurement record incorrectly.

Five AA-size Alkaline batteries power the Em50. With the radio or cellular modules disabled, 
a set of Alkaline or Lithium batteries can last for several years. The battery life for Em50Gs 
and Em50Rs varies depending on how you set up the transmission (Section 6). Battery power 
in the Em50R and Em50G can last from 6 months to over 1 year. You can check the battery 
level status when the Em50 is connected using any ECH2O software. When the battery life 
indicator shows that your Em50 batteries are <5%, you should replace them.

3.2  INSTALLING SOFTWARE
The ECH20 Utility and DataTrac 3 software (installation USB Drive attached to the cover of 
this manual) allows you to collect and manage data from your device.

NOTE:  This manual documents ECH20 Utility. Most tasks that can be performed using the ECH20 Utility can also be 
accomplished using DataTrac 3. For more information about using DataTrac 3, please refer to the DataTrac 3 Manual.
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To install ECH20 Utility or DataTrac 3, plug the USB Drive into your computer and wait for it to 
autolaunch. If it does not launch, go to My Computer, select the USB Drive, and click double 
click on the software file. A driver for the accompanying USB cable can also be installed at 
this time.

Occasionally, new versions of ECH2O System software are available on METER's website.

You can find your current software version in the "About" option of the Help menu in 
the ECH20 Utility and DataTrac 3. If you are connected to the Internet, select "Check for 
Updates" in the Help menu to see if there is a newer version available.

The METER USB Cable driver should install automatically. However if it does not, you must 
install a driver for the USB Cable Adapter (UCA) before you can use it to communicate with 
your logger. You can find the driver installer on your ECH2O System Software USB Drive or on 
METER's website at metergroup.com.

3.3  CONFIGURING IN ECH20 UTILITY
Before field installation, the Em50 needs to have certain parameters set, such as name, date, 
time, measurement interval, and communication mode. The Em50R and the Em50G do not 
communicate wirelessly until properly configured. Follow steps 1 through 6 to configure the 
logger.

1.	 Open the ECH20 Utility program.

2.	 Plug the USB cable (included with your Em50) into the logger COM port and then the USB 
port of your computer.

Figure 2  Port diagram

3.	 At the top of the screen, select the appropriate COM port from the "Connect Via" drop-
down menu, then click on the Connect icon. If you are using the USB Cable Adapter, look 
for the Connect Via option that includes "METER UCA" in the COM port name.

NOTE:  If you cannot connect to your Em50, you may need to install the driver for the USB cable. To download a 
driver go to metergroup.com.

4.	 Once you have successfully connected, the menus on the main screen become active.

http://www.metergroup.com
http://www.metergroup.com
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5.	 At the device setup screen that appears, click on the various fields to enter a name for 
your logger and choose sensor types for each port.

When using the Em50R, select the radio settings you plan to use (Section 6). Click 
"Apply" to save the changes. When using the EM50G, select your communication 
configurations (Section 4).

6.	 Press the "Disconnect" icon when finished.

3.4  FIELD INSTALLATION
NOTE:  To watch a 5-min video on installing soil moisture sensors with an Em50 logger, visit metergroup.com.

The Em50 can serve as a collection station for up to five sensors. The Em50 is compatible 
only with sensors made by METER such as the ECH2O water content probes, rain gauge, 
temperature sensors, etc. Follow steps 1 through 5 to perform a field installation the 
Em50 and sensors.

1.	 If you are using the Em50R or Em50G, perform a telemetry test to check the wireless 
signal. If your signal is low or does not exist, move to an alternative location. (Sometimes 
only a few feet away is sufficient.)

2.	 Install your sensors as directed in their respective manuals.

3.	 Plug the sensor stereo cable connector firmly into the Em50 input port.

4.	 On the top and bottom of the Em50, there are two loopholes. Use these holes to fasten 
the Em50 to a mounting post using the included zip ties or a similar fastener. Make sure 
it is installed in an upright position, with the five input ports underneath. In this position, 
rain and spray are shed by the enclosure and drip off without affecting the contents of 
the Em50 enclosure.

5.	 Configure the Em50 using ECH20 Utility or DataTrac 3.

6.	 Install the Em50/Em50G Solar data loggers in a location that ensures the solar panel 
receives the maximum amount of sunlight. In the northern hemisphere, this typically 
means that the data logger faces the south. In the southern hemisphere, this typically 
means that the data logger face the north.

NOTE:  Never immerse the Em50 in liquids.

NOTE:  Make sure to install the Em50 upright to reduce the possibility of water entering the Em50 enclosure.

NOTE:  Do not install Em50R or Em50G wireless loggers near large metallic objects, as these can attenuate the 
radio signal.

http://www.metergroup.com
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4.  SOFTWARE AND CONFIGURATION
We designed the Em50 series data loggers to have a simple configuration and no data 
logger programming. The software packages are key to the effectiveness and ease of the 
Em50 Series data loggers. The software fits a variety of users and allows quick and easy 
access to the data logger.
•	ECH20 Utility:  Use ECH20 Utility for basic data logger configuration and direct connect 

data download in Excel format. Customers can use ECH2O Utility on any Windows laptop, 
netbook, or desktop computers.
NOTE:  ECH20 Utility cannot download Em50G data from METER Data Service.

•	DataTrac 3:  Use DataTrac 3 for configuring and organizing multiple Em50 series loggers. 
DataTrac 3 database system automatically updates newly downloaded data and creates 
graphs of complete data sets from each logger. DataTrac 3 is the premier software for 
downloading and collecting data from Em50R or Em50G systems. This software is best if 
you are interested in viewing your data on a daily or weekly basis because of the software 
ability to automatically append new data collected by each logger.

•	Em50G WebViewer: Use the Em50G WebViewer application if you do not have a 
DataTrac 3 license to remotely download data as Microsoft Excel spreadsheets and view 
graphs of your data for the past week through the METER Data Service. Access your Em50G 
data through the Em50G WebViewer at ech2o.com.

DataTrac 3 has a User Manual available from the support section of the product page 
at metergroup.com/em50-support. This chapter details ECH20 Utility and the Em50G 
WebViewer.

4.1  ECH20 UTILITY SOFTWARE INSTALLATION
ECH20 Utility provides a user-friendly interface for configuring and downloading data from 
the Em50 logger. After installing the program (Section 3.2), launch it and you should see the 
Main screen.

http://www.ech2o.com
http://www.metergroup.com/em50-support
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Figure 3  ECH2O Utility Main screen

In the Main Screen, you can set all logger configuration parameters with visual controls. 
At the top of the program window is a toolbar for interacting with the Em50. To the left is a 
battery indicator.

To the right is the Connect Via menu, where you can select a COM port, the Connect button 
(which displays Disconnect when you are connected to an Em50), the Download button that 
downloads data saved on the Em50 onto your computer, and the Scan button, which scans 
all of the sensors connected to each port on the Em50 and returns a real-time reading. This 
section covers these functions in detail. 

4.2  COMMON TASKS IN ECH20 UTILITY

4.2.1  CONFIGURING THE EM50/EM50R/EM50G
The Em50 does not require any programming, but it does have several parameters that 
control identity and function. To change a parameter, connect to your device, change the 
parameter, then click Apply to send the parameter changes to your device. 
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Name:  Each Em50 device should have a unique name. The default name is the unit serial 
number. You can change this to any legal name you want. A legal device name uses upper 
and lower case letters, numbers, underscores, and hyphens. Spaces and most punctuation 
are not legal name characters. ECH20 Utility prevents you from choosing a name containing 
illegal characters.

Serial Number:  When set in the factory, this is a read-only value.

Measurement Interval:  The Em50 and Em50R loggers allow you to select a measurement 
interval between 1 and 1,440 min while the Em50G allows you to set a measurement interval 
between 5 and 1,440 min. A measurement interval of zero (0) or "off" stops the logger from 
making measurements.

Port Sensor:  The Em50 requires you to identify the sensor type for each of the five sensors.

Cellular Settings:  To turn the cellular network of the Em50G on or off, click the "Configure" 
button in the "Communication Option" section. The cellular network is active when "Upload 
data to ECH2OData.com" box is checked and is off when the box is not checked. The 
Em50G is uploading data to the METER Data Service (on) by default. See Section 5 for more 
information on the Em50G.

Choose up to six upload times. Default upload times are: 6-7 AM, 10-11 AM, 1-2 PM, 4-5 PM. 
To conserve battery power, choose fewer upload times. The Em50G high data use logger 
allows you to transmit data every 15 min.

Click Ok after making configuration changes. Click Apply to save communication settings in 
your Em50G. Your current settings show up in the communications option field.

ECH20 Utility helps you evaluate the quality of the cellular connection on your Em50G with 
the Communication Test feature. Please see Section 5 for a step-by-step guide to running the 
Em50G Communication Test.

Radio Settings:  Only devices that have a radio module support these options (Em50R, 
DataStation). See Section 6 for more information on using the radio settings.

4.2.2  DOWNLOADING DATA WHEN DIRECTLY CONNECTED
Once you properly configure and install the Em50, it is ready to begin making and storing 
sensor measurements. Stored data can be downloaded from the logger starting at two 
places in the logger memory. The "Download New" option downloads the data stored since 
the last successful download. The "Download All" option downloads all the data currently 
stored in the Em50. The "Download" button on the toolbar corresponds to the Download New 
option. Any model of Em50 data logger supports downloading data when directly connected 
to the logger with ECH2O System software.
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Follow steps 1 through 5 to download data.

1.	 Use the USB cable to connect the Em50 to your computer.

2.	 Choose "Direct on" the appropriate COM port from the Connect Via drop-down list and 
press the "Connect" button. If you encounter connection errors, please see Section 8 or 
the ECH20 Utility Help File.

3.	 Once connected to an Em50, either click the Download button on the toolbar, or go to the 
Data Menu and select a download option as described above.

4.	 When saving data, the File > Save dialog suggests a name based on the connected logger 
name and the time and date. However, you can enter any name by typing it into the "File 
name" field.

5.	 Choose the file format (Common formats include .xls, .csv, or .dxd) you prefer then click 
Save. ECH20 Utility then downloads the data and creates the file.

ECH20 Utility can save your data in several different file formats.

Excel Workbook File (.xls):  Converts the raw downloaded measurement data into 
engineering values appropriate for each sensor type. The converted data saves to sheet 1 of 
the workbook and raw data saves to sheet 2. You can use the raw measurement data to apply 
custom calibration to your sensor data.

DataTrac 3 Data File (.dxd):  Saves the file in a format that DataTrac 3 can import. Each .dxd 
file contains information about the ECH2O logger settings, identity, and status along with the 
raw data for each sensor.

Processed Data Text File (.txt):  Converts the raw downloaded data into engineering values 
appropriate for each sensor type. Data are saved as a tab delimited text file.

Raw Data (.csv):  Saves the raw data in the form downloaded from the logger.

NOTE:  The DataTrac 3 file format (.dxd) is a useful way to store data for later manipulation. Each .dxd file contains 
information about the ECH2O logger settings, identity, and status along with the raw data for each sensor. ECH20 Utility 
can process a .dxd file into an Excel file or a processed text file. This allows you to process your raw data again with 
different settings or file formats.

4.2.3  OTHER DATA DOWNLOAD OPTIONS
METER designed the Em50R to be part of a wireless sensor network. In this mode, Em50R 
transmits measurement data to a DataStation. You can then download the measurement 
data from all the Em50R loggers in your network from one location. The communication 
protocol also confirms delivery of the data and continues to request data until it receives the 
complete data package. See Section 6 for more information on setting up logger networks.

We designed the Em50G logger to upload your measurement data to METER Data Service 
using the cellular network. This makes it easy for you to use the Internet to download your 
measurement data from anywhere in the world. Please see Section 5 for more information.
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NOTE:  ECH20 Utility uses the default conversion equation for each sensor when converting raw data to processed 
data. For more information about the default conversion equations, please see your logger or sensor manual.

An Em50R supports wireless data downloading. ECH20 Utility can establish a two-way radio 
connection between your computer and a remote Em50R through the Rm-1 Radio Modem. 
Once you establish this connection, you may download data from the Em50R just like it is 
directly connected to the logger. Section 6 provides more information on setting up two-way 
wireless communications.

4.2.4  ERASING DATA
If you need to erase the data on your Em50, go to Data > Erase Stored Data. You should erase 
your data if you change the Em50 configuration settings, such as what type of sensor is in 
each port. After selecting the Erase option, it asks if you want to continue. Click Cancel to 
return to the program, or Erase Data to continue.

NOTE:  Activating this feature permanently erases all stored data.

4.2.5  INSTANTANEOUS MEASUREMENTS (SCAN)
ECH20 Utility gives you the ability to take real-time sensor measurements with your 
Em50 logger. This is most useful as a troubleshooting feature to test if a sensor is reading 
properly. You can also see how sensors react to environmental changes. Follow steps 1 and 
2 to take real time measurements.

1.	 Click the "Scan" button in the toolbar, or go to Actions > Scan Logger Ports. The 
Em50 takes a reading on each of the ports, then displays the Em50 Port Scan screen.

Figure 4  Em50 Port Scan screen
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2.	 The Port Scan screen displays all five ports should display with the measurement for 
each port in the units appropriate for the sensor. You can change measurement units 
in the Preferences Menu (Section 4.3.2). Click the sensor name to see the reading as 
raw data.

The five ports should display with the measurement for each port in the current selected 
unit. If nothing is plugged in to a port, the reading for that port is zero.

NOTE:  The Em50 does not store data that it measures with the scan function.

4.3  ECH20 UTILITY MENUS
ECH20 Utility features six menus that allow you to access the program features. These six 
menus are the File, Edit, Data, Actions, Window, and Help menus. Section 6 discusses all 
menu features.

4.3.1  FILE MENU
Save Settings File: Selecting the "Save Settings File" option from the File menu creates a 
data file that contains all of the settings and information associated with the connected 
Em50. This feature is useful for transferring logger configurations between ECH20 Utility and 
DataTrac 3. By default, the name of the settings file is the name of the selected Em50. After 
naming the file and selecting where it saves, click Save to create the file.

Convert Data File: ECH20 Utility "processes" or converts raw ECH2O sensor data to 
processed data. This feature works by reading .dxd files containing raw data and 
outputting the processed data into a different file format (such as .xls or .txt). You can 
convert DataTrac 3 data files (.dxd). Only files saved with ECH20 Utility can be converted to 
processed files. You can choose to save your processed files as an Excel file or text file.

4.3.2  EDIT MENU
THE PREFERENCES WINDOW
The Preferences Window is the main feature of the Edit Menu, it has four tabs for navigation: 
The Measurements, Data Files, Communications, and Application tabs.
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Figure 5  ECH2O Utility Preferences: Measurements tab

1.	 Measurements Tab
The Measurement Units feature is the main function of the Measurement tab. These field 
entries determine the unit values that display when you save downloaded data as Excel, 
processed, or raw data files. ECH20 Utility supports displaying some measurement data in 
multiple units. For example, it allows you to choose degree Celsius or degree Fahrenheit for 
temperature sensors.

To set your preferences for measurement units, choose the Measurements tab in the 
ECH20 Utility Preferences window. Locate the type of measurement and select a unit from 
the drop-down menu next to it. Click "Close" to apply the changes.

The Power Noise Filter is the other feature of the Measurements tab. The AC electrical 
power in your office or home can add a subtle amount of noise to the data logger sensor 
measurements. The logger Power Noise Filter setting is designed to eliminate this electrical 
noise that comes from the AC power distribution system. You should set the value of the 
Power Noise Filter to match the frequency of the power cycle where you live. In North 
America and most of Asia, this is 60 Hz (the default value). In most of Europe the electrical 
frequency is 50 Hz. This feature only needs to be set once, as the program automatically 
updates each connected device filter.
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2.	 Data Files Tab

Figure 6  ECH2O Utility Preferences: Data Files tab

The Column Headers feature provides a title for each column that corresponds to the port 
number, measurement type, and unit. Column headers for saved data files are turned on by 
default, and apply only to processed and raw MS Excel data, as well as processed text data. 
De-select "Include column headers" to turn off the column headers for these file types.
You can control the format of date and time values in the Data Files tab under the section 
"Date and Time Formatting in Data Files." By default, the time and date are formatted using 
the settings in the Windows Regional & Language Options control panel. You can modify this 
to display the date and time in dd/mm/yyyy format with either a 12- or 24-h clock. To change 
the format, select an option from the menu, then click Close to apply the changes.

3.	 Communications Tab
The Communications tab has items that control how the serial communication works 
between ECH20 Utility and your Em50. Generally you should not adjust these settings unless 
you are experiencing problems communicating with your Em50.
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Figure 7  ECH2O Utility Preferences: Communications tab

The Command Retries feature sets the number of automatic retry commands the 
ECH20 Utility automatically sends to your Em50 when there are errors. For most 
circumstances, the default retries work well. If you experience unreliable communication 
with your Em50, you can try increasing the Direct Connect Retries. 

The Maximum Baud Rate feature allows you to set the Baud Rate for Direct Connection. 
Set a baud rate lower than the default 115,200 baud if you consistently experience serial 
connection problems.

The Communications Port List enables the "Force find all comm ports" feature. Use this 
feature when the USB to serial adapter does not appear in the Connect Via communication 
port list. ECH20 Utility is compatible with most USB to Serial adapters. Some models of USB 
to Serial adapters are not found by the serial port enumeration feature of ECH20 Utility. If 
your model of USB to Serial adapter is not recognized, enable Force find all Communication 
Ports in the Preferences Menu by going to the Communication tab, and enabling the check 
box at the bottom of the screen. Enabling this option may find other serial ports that are not 
available for use by the ECH20 Utility (for example, modems installed in your computer).

NOTE:  Enabling the Force find all Communication Ports option may result in ECH20 Utility finding communication 
ports that are unavailable for its use.
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4.	 Application Tab

Figure 8  ECH2O Utility Preferences: Applications tab

The Automatic Internet Version Check instructs ECH20 Utility to automatically check for a 
newer version using Decagons Internet version-check engine. When you select this option, 
while running ECH20 Utility and connected to the Internet, the software notifies you when 
a newer ECH20 Utility version becomes available. You can turn off the automatic check by 
unchecking this option. You can manually check for updates any time using the "Check for 
ECH20 Utility Updates" option in the Help menu.

Automatic Clock Synchronization keeps the device clock synchronized with your PC clock By 
default, the ECH20 Utility automatically synchronizes the logger date and time to the time 
set on your computer. You can disable this feature by unchecking this option. You can also 
update the date and time in your logger any time it is connected by selecting Actions > Set 
Date/Time.

Selecting the Error Log File option instructs the software to add more detailed error 
messages to log files. The ECH20 Utility keeps a log file of errors and events, but adding more 
messages to this file is useful for troubleshooting. Check this option to add more error and 
event messages to the error log.

The Date and Time Display in the ECH20 Utility controls how the EM50 displays the date and 
time in the toolbar status area. By default, the time and date use the settings in the Windows 
Regional & Language Options control panel to determine display. You can modify this to 
display the date and time in dd/mm/yyyy format with either a 12- or 24-h clock.
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4.3.3  DATA MENU
The Data menu has four options: Download New Data, Download All, Report Stored Data, and 
Erase Stored Data. Please refer to their respective portions of Section 4 for more information 
on these functions.

4.3.4  ACTIONS MENU
Connect/Disconnect performs the same function as the connect/disconnect button in the 
toolbar. It initiates a data communication connection between your Em50 and your computer. 
You must first connect to your Em50 before downloading data.

OTHER ACTIONS MENU FUNCTIONS
The Get Settings command retrieves all the port and configuration settings from your Em50. 
These settings are automatically collected when you connect to your Em50. You can use this 
option to check to make sure your changes are stored in the Em50.

The Apply Settings feature applies the parameters you changed to your Em50. This operates 
just like the Apply button on the main screen. This option is only available when there are 
parameter changes available to send to the Em50.

The Scan Logger Ports option allows you to take readings from each port independent of the 
others. See Section 4 for details and procedures.

Use the Digital Sensor Terminal for SDI-12 addressing and query of our digital 
SDI-12 sensors. See the respective manuals for these sensors for additional information on 
SDI-12 capabilities.

The Set the Date/Time command instructs the ECH20 Utility to set the Em50 time and date 
according to the time and date on your computer.

Use Communication Test when you connect to the Em50R or Em50G loggers using 
ECH20 Utility to see how well the logger wireless communication is working. If the test 
suggests that you have a poor connection, you can move to a new location and re-try the 
communication tests.

Use List Cellular Carriers for troubleshooting to see which cellular carriers are available 
within the range of the Em50G logger.

Use the Configure Radio Modem to change the channel and subchannel for your Em50R or 
DataStation.

The Device Tools submenu contains several items.

The "Test Device Firmware" option determines if you have any firmware (the internal 
software that runs the Em50) errors. To initiate a firmware test, select Actions > Device Tools 
> Test Device Firmware. This automatically tests the integrity of your Em50 firmware, and 
report if it reads as Bad or Good.
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The "Initialize Radio Module" option resets the radio module to the default setting. This 
option applies to Em50Rs and DataStations only.

The "Initialize Device" option initiates a form of hard reset for your Em50. ECH20 Utility 
resets your Em50 and rewrites all the logger settings. All your measurement data is erased. 
This option is useful for troubleshooting a logger that is not working as expected.

NOTE:  Initializing your Em50 deletes all stored data. Make sure any data has been downloaded out of the Em50 before 
initiating a reset.

4.3.5  WINDOW MENU
The Window menu contains the "Show Terminal" command. The terminal window allows 
you to directly enter commands for your Em50 and is mainly used for troubleshooting and 
diagnosis.

4.3.6  HELP MENU
The Help menu allows access to the ECH20 Utility help file, allows you to check for program 
and firmware updates, and displays information about your copy of the ECH20 Utility.

The ECH20 Utility Help menu item opens the help file. It contains some of the information 
found in this manual.

The Send Feedback to Decagon menu item helps you send product feedback, bug reports, 
or feature requests to Decagon. Your computer must be connected to the Internet for this 
feature to work. See Appendix B for more information.

The Check for Utility Updates item checks for the newest available version of the 
ECH20 Utility. Make sure you are connected to the Internet, then select Help > Check for 
ECH20 Utility Updates. The program checks to see if there is a newer version available. 
If there is, it directs you to the web page where you can download it. To check for a 
newer version of the ECH20 Utility, choose this menu item. Checking for updates for the 
ECH20 Utility uses Decagon's version-check web engine. Your computer must be connected 
to the Internet for this feature to work.

The Check for Device Firmware Updates menu item is only available when you are connected 
to an Em50 (or other ECH2O device). It compares the firmware version of your Em50 with 
the latest version available from Decagon. You can download a firmware updater when a 
new version is available. Your computer must be connected to the Internet for this feature 
to work.

About the ECH20 Utility opens the About window. You can see the version of your copy of 
ECH20 Utility here.



24

Software and Configuration

4.4  EM50G WEBVIEWER
The Em50G WebViewer is a web-based application that securely connects your logger to the 
METER Data Service to download Excel sheets and display weekly graphs of your data. For 
more specific information and assistance, please find the Em50G WebViewer Help Files by 
clicking the "Help" link on the WebViewer website.

4.4.1  ADDING A USER
The Em50G WebViewer requires you to either sign in or add an account. If you have already 
made an account with the METER Data Service through either the old Em50G downloader or 
DataTrac 3, your account is already set up and you just have to enter your credentials to sign 
in to the WebViewer. Otherwise, you must make an account.

To make an account, begin by clicking on the "Create User" link below the "Sign in" button. 
This brings up the METER Data Service Registration form. Enter the required information and 
click on the "Register" button at the bottom. If all goes well with your registration, you should 
see a page informing you that your registration was successful. Click on the "login" link, and 
you are ready to add new Em50G loggers to your account.

4.4.2  ADD A SUBSCRIPTION
In order to view data from an Em50G, you must first "Subscribe" to it. You are not limited by 
the number of Em50G loggers you can subscribe to. See the Em50G WebViewer Help Files for 
more information on subscribing to your data logger.
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5.  EM50G CELLULAR COMMUNICATION
The Em50G data logger has a GSM/GPRS cellular module that enables the logger to upload 
sensor measurement data to METER Data Service. Your measurement data is available for 
download directly to your Windows computer at any time, anywhere in the world where you 
have Internet access. To extend your service plan contact Customer Support.

5.1  METER DATA SERVICE
The Em50G uses "push" technology to upload measurement and logger status data to 
the METER Data Service at regular daily intervals. This type of push technology allows the 
Em50G to keep its cellular hardware powered off for most of the time allowing long battery 
life. The logger uses a unique cryptographic signature and checksum to protect the integrity 
of the your data as it is transferred over the cellular network and Internet as it is uploaded to 
the METER Data Service.

The Em50G keeps track of the data successfully uploaded to the METER Data Service. If your 
logger is unable transfer data during one regularly scheduled session, the data is included in 
the next upload session.

Once stored in the METER Data Service, you can download your measurement data from the 
Internet. Downloading data does not remove it from the Data Service. Decagon safely stores 
your data for download at any time.

5.2  CELLULAR SERVICE
Decagon makes using the cellular network easy by including the first year of service with 
the Em50G. Decagon partners with over 200 GSM/GPRS network operators in 120 countries 
to provide cellular service all over the globe. We configured your Em50G with an appropriate 
SIM card for the location where you plan to use your logger. The SIM card and associated 
service METER provides is only for use with the Em50G as outlined by the usage agreement 
in Appendix C.

NOTE:  Please check with METER before moving an Em50G from one country to another to make sure your service plan 
is appropriate for the new location. To extend your service plan or to troubleshoot your cellular service, please contact 
METER or the authorized METER distributor where you purchased your Em50G.

5.3  CELLULAR COVERAGE
The Em50G requires GSM/GPRS cellular service to upload measurement data to METER Data 
Service. In the USA, the Em50G with the 2G modem operates on the T-Mobile network and is 
not compatible with the Verizon, AT&T, or Sprint networks. The Em50G with the 3G modem 
operates on the T-Mobile and AT&T networks and is not compatible with the Verizon or Sprint 
networks. Please contact METER for specific questions regarding 2G versus 3G modules in 
the Em50G. Outside of the USA, the Em50G should be compatible with technology used by 
most cellular carriers.
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ECH20 Utility offers a "Communication Test" feature that allows you to evaluate the quality 
of the cellular network coverage where you plan to install the Em50G. This allows you to 
evaluate the cellular coverage before installing your logger. Repositioning your logger a short 
distance may improve your cellular coverage.

For measurement site planning, it may also be useful to consult the network coverage tools 
offered by each carrier. Please contact METER for specific questions about the cellular 
coverage offered by our partner networks. 

5.4  EM50G CONFIGURATION AND SETTINGS
The Em50G uploads data to METER Data Service right out of the box. To start logging and 
uploading data, configure your logger with the type of sensors installed in each port and turn 
on sensor logging by choosing a measurement interval. The Em50G uploads data according 
to the default schedule (uploading between 6-7 AM, 10-11 AM, 1-2 PM, 4-5 PM each day).

Figure 9  Em50G Cellular Configuration Window

Use ECH20 Utility to change these default settings. To turn the Em50G cellular network 
on, off, or to change the upload times, click the "Configure" button in the "Communication 
Option" section. The cellular network is active when you check the "Upload data to 
ECH2OData.com" box and is off when you uncheck the box. Choose up to six upload times 
that correspond to the times when you want to download the most up-to-date sensor data. 
(Figure 9) The Em50G uses a random time within the hour to reduce resource loads on the 
cellular network and Data Service. To conserve battery power, choose fewer upload times.

NOTE:  Please contact METER if your application requires measuring sensors more often than every 5 min or if you 
need data uploads more often than six times a day.
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Click "OK" after making configuration changes. Click Apply to save communication settings 
in your Em50G. Your current settings show up in the communications option field.

NOTE:  Sensor data recorded by the Em50G while it is configured not to upload data to the Data Service is stored in the 
logger but does not upload to the Data Service. Turning the upload feature on initiates uploading data collected on the 
next measurement interval.

5.5  COMMUNICATION TESTING
ECH20 Utility helps you check the quality of the cellular communication of your Em50G using 
the Communication Test feature. Open the Em50G Communication Test dialog by clicking the 
Test button or choosing "Communications Test..." in the Actions menu.

Figure 10  Em50G Communication Test Window

The test takes approximately 30 to 60 s while the Em50G establishes a connection with 
the cellular network and sends test packets to the METER Data Service. Once the tests are 
finished, the "Connection Quality" field reports connection quality based on cellular signal 
strength and successful packet transfers. After the initial test is finished, clicking the Test 
button again updates the cellular signal strength and re-sends test packets. Subsequent 
tests are much quicker than the initial test because the Em50G is already connected to the 
cellular network and the METER Data Service. Test your connection quality again to find the 
best spot to install your Em50G. If one test fails, be sure to continue testing until your test 
returns multiple successes.

NOTE:  The cellular radio is on while the Em50G Cellular Test dialog window is open. Be sure to close the window when 
you are done testing to preserve battery power.

If the Em50G Cellular connection quality is poor, try moving your logger a short distance to 
improve the signal strength. Also, consider elevating the antenna by elevating the logger or 
using an antenna extension cable to improve signal strength. In some cases it is necessary to 
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use directional antennas to obtain a sufficient cellular signal. Please contact METER or your 
METER representative for help choosing the correct antenna for cellular frequencies at your 
location.

The Communication Test is checking both the cellular signal strength and the connection 
to the METER Data Service. If the Data Service is temporarily unavailable due to Internet 
problems, the connection quality reports a failure even if you have strong cellular signal. 
If your cellular signal strength is good (above 12'), then it is reasonable to expect good 
connection quality once the Em50G can re-connect to the METER Data Service.

NOTE:  The measurement data collected by your Em50G is automatically queued for the next successful connection 
to the METER Data Service. Short term cellular or Internet outages do not impact the integrity and continuity of your 
data.

5.6  DOWNLOADING DATA
You have two options for downloading the Em50G sensor measurement data.

5.6.1  DIRECT DOWNLOAD
Like all Em50 loggers, the Em50G stores more than 36,800 sensor readings for each of the 
five sensor ports. You can use any ECH2O system software to directly connect to the logger 
for data download. Your data are always safely stored in non-volatile memory as a backup in 
the unlikely event of data loss on your computer. For downloading instructions when directly 
connected, see Section 4.2.

5.6.2  INTERNET DOWNLOADING
The Em50G and METER Data Service make downloading your measurement data over the 
Internet convenient and easy. Use DataTrac 3 to subscribe to data collected by your Em50G. 
The Em50G WebViewer web application is also designed to download and display Em50G 
data.

NOTE:  ECH20 Utility does not connect to the METER Data Service for downloading data over the Internet. You must 
use either DataTrac 3 or the WebViewer.

You can choose to use either DataTrac 3, or the free Em50G WebViewer web application, 
depending on your needs. DataTrac 3 can be installed from the installation USB Drive that 
came with your logger manual, or you can install the latest version from metergroup.com. 
To access the Em50G WebViewer, go to ech2o.com. For more information on accessing and 
downloading data from the Em50G WebViewer application, see the Em50G WebViewer Help 
Files, found by clicking on the Help link on the Em50G WebViewer website.

5.7  DOWNLOADING WITH DATATRAC 3
When you first launch the DataTrac 3 application, it prompts you to enter your user contact 
information as shown on Figure 11.

http://www.metergroup.com
http://www.ech2o.com
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Figure 11  User Configuration screen

METER uses this information to link you to your subscribed Em50G so that we can provide 
customer support in the event that your logger is not working correctly. You can update this 
information at any time by choosing "User Configuration" from the Settings menu. Once you 
have completed the user information, you are ready to add new subscription information.
In order to download data over the Internet for a specific logger, you must first "subscribe" 
to that Em50G logger. You may subscribe to any number of Em50G loggers. Remember 
that during the subscription process you must be connected to the Internet. Follow steps 
1 through 5 to subscribe using DataTrac 3.

1.	 Click Set-up > New and then "Em50 subscription." The Add Subscription Window appears.

Figure 12  Add Subscription Window
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2.	 Enter the unique device ID and password for your Em50G. You can find this information 
on the brightly colored card that came with your Em50G logger. Keep this card in a safe 
place.

3.	 Make sure the "Server" option is set to www.ECH2OData.com (Default).

4.	 Pick the amount of data you want to include in the first download. If this is the first 
time you are downloading data from this logger, you should choose the "All Data Points" 
option. If you are only interested in downloading data uploaded over the last day or last 
week, choose "Last Day" or "Last Week" respectively.

5.	 Click Ok. DataTrac 3 then communicates with the METER Data Service to verify the 
information you have entered. 

Repeat the above steps for each of your Em50G loggers. You can add new logger 
subscriptions at any time.

Click the Download button to download any new measurement data sent by your Em50G 
loggers since the last time you downloaded. Data files successfully downloaded for each 
logger is saved in the DataTrac 3 auto-import directory (\verb|My Documents\ECH2O 
DataTrac\|*\verb|AutoImport\|). When DataTrac 3 launches, it automatically processes the 
files in this directory by appending this data to the appropriate logger.

NOTE:  DataTrac 3 lists loggers in the New Devices section by the logger name when it encounters a logger it has not 
seen before. Select your Em50G by its name, and choose the Configure button on the DataTrac toolbar. Set the location 
information if desired, then press Ok.

5.7.1  DOWNLOADING WITH EM50G WEBVIEWER
For help on downloading data through the Em50G WebViewer web application, please refer 
to the Em50G WebViewer Help Files, located under the Help link on the WebViewer website.

5.7.2  MANAGING SUBSCRIPTIONS
The DataTrac 3 application attempts to download data from each logger in the Main window. 
If you want to stop subscribing from a logger permanently, select the logger in the list and 
choose "Delete Subscription" from the File menu.

The Em50G WebViewer also attempts to download data from each of the Em50Gs you have 
subscribed to. For help on unsubscribing from loggers, see the Em50G WebViewer Help Files, 
located under the Help link on the WebViewer website.

5.7.3  SHARING DATA
The Em50G and METER Data Service also make it easy to share your measurement data with 
a colleague or collaborator. You control who has access to specific Em50G data by providing 
the unique Device ID and Password pair associated with each logger (found on the brightly 
colored card shipped with each Em50G).
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NOTE:  You should keep the Em50G Device ID and Password card in a safe place. Do not leave it inside the Em50G 
logger case. Only share the information on the card with people you wish to have access to the data published by your 
Em50G logger.

NOTE:  There is no limit to the number of people who can subscribe to each Em50G. Each subscriber either runs their 
own copy of the DataTrac 3, or uses their own METER Data Service account on the Em50G WebViewer web application. 
One subscriber data download does not interfere with another subscriber data download.
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6.  EM50R RADIO TELEMETRY
This section gives you a brief overview of the radio telemetry available in the ECH2O system. 
This information only applies to Em50R. The ECH2O system supports two types of radio 
telemetry: "two-way" mode and "Transmit" mode. Consider one or both types of radio modes 
when designing your ECH2O telemetry system. The "Confirm Delivery Transmit" mode ensures 
the most complete data transfer and the best battery life. However, there are some unique 
cases where you may want to use the other available modes.

NOTE:  You need either a DataStation or an Rm-1 to utilize the radio communication capabilities of the Em50R.

ECH2O telemetry networks require each remote radio logger to have a unique name. Each 
logger leaves the factory with the name set to the logger unique serial number. You can easily 
change the name of the logger to help you identify or organize your data. You should not give 
two loggers the same name. Two loggers with the same name interfere with each other when 
communicating over the radio.

6.1  TRANSMIT RADIO TELEMETRY
The Transmit Radio mode helps you create a simple network of remote radio loggers all 
transmitting data to a DataStation radio base station. The DataStation stores data from 
all the remote loggers in one convenient place. Typically, you connect a DataStation to your 
computer where you can easily download the data for use in DataTrac 3. Unlike the two-way 
Radio modes, you cannot remotely change logger settings when using this mode.

When a logger is in Transmit mode, it only turns on the radio when it has new data to 
broadcast. For example, when you set the measurement interval in your logger to 60 min, the 
logger stores your data every hour and then broadcasts the data to a listening DataStation. 
The actual transmit time is randomly delayed for several minutes to prevent two or more 
radio loggers from interfering with each other.

The Transmit radio modes use less battery power because the radio is off most of the time. 
The Em50R is designed to work approximately 12 months in Transmit mode.

NOTE:  A DataStation is a receiver. It does not cause the remote logger to send data. If your DataStation is powered 
off for some time, it does not receive data sent by the remote loggers. However, the logger stores the missing data for 
download.

6.1.1  TRANSMIT RADIO MODES
Use the Configure button in the Communication Hardware options to choose one of the 
following radio modes that support Transmit communication.

Confirmed Delivery Transmit: This is the recommended mode since it is the most robust 
Transmit radio mode. The radio logger adds a checksum to the data packet before 
broadcasting the data to a DataStation. The logger then waits for the DataStation to 
confirm it correctly received the data packet. If the logger does not hear the confirmation, it 
retries sending the packet again. The logger stops trying to transmit to a DataStation after 
25 attempts.
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Transmit Only:  This is the original Transmit radio mode. It does not offer the advantages of 
the Confirmed Delivery Transmit mode. You should use the Confirmed Delivery mode when 
possible. Em5R (discontinued) loggers only support this Transmit radio mode.

Transmit + two-way and CD Transmit + two-way:  These modes combine the two-way Radio 
mode and the Transmit Radio mode. You could use these modes while configuring and testing 
your radio network. You should not leave your radio logger in these modes because they use 
the most battery power of all the radio modes. Using Transmit + two-way and CD Transmit 
+ two-way radio modes with the wake interval set to 1 or 2 causes your logger batteries to 
drain very rapidly.

6.1.2  TRANSMIT BEST PRACTICES
Transmit modes are most useful when you have three or more loggers installed within radio 
range of each other. There is no set limit to the number of radio loggers broadcasting to a 
DataStation. Use this mode for as few as one logger and as many as 50 or more loggers. 
You should use the Telemetry Test feature of ECH20 Utility to test the connection from your 
logger to the DataStation.

NOTE:   Em50R loggers must have firmware version 1.12 or later to enable the Confirmed Delivery Transmit mode 
and Telemetry Test feature. Your DataStation must have firmware version 1.09 or later to receive Confirmed Delivery 
Transmit mode data packets. Contact METER for an application note that covers the steps needed to upgrade your 
hardware.

NOTE:  See section on DataStation Networks for step by step instructions for configuring your DataStation and remote 
radio loggers.

6.2  TWO-WAY RADIO TELEMETRY
The two-way Telemetry Mode lets you establish a two-way connection with a remote 
radio logger. Once connected to the remote logger, you can download data and change 
most settings just like you were connected directly to the logger with a serial cable. 
Communicating with a remote radio logger requires you to have a Rm-1 radio modem 
connected to your computer. Connect to the remote radio logger through the Rm-1.

When a logger is in a two-way Radio Mode, it turns on its radio every 45 s. While the radio is 
on, the logger listens for connection attempts from a Rm-1. If the logger does not hear any 
connection attempts, it turns off the radio. If the logger hears a connection attempt, it leaves 
the radio on for several seconds listening for login commands from ECH20 Utility. It takes up 
to 60 s to connect to the remote logger.

When you are finished interacting with the remote radio logger, you press the disconnect 
button. ECH20 Utility sends a logout command to the remote logger to indicate the end of 
the communication session. When the remote logger hears the logout command, it waits 
for 10 min before listening for additional connection attempts via the radio (you can always 
direct connect to your logger). This allows you to connect to other loggers with the same 
radio settings. Otherwise, the first logger you contacted may reconnect. This would prevent 
you from connecting to your other loggers.
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The two-way modes generally consume the most power. The Em50R is designed to work for 
several months in the two-way modes.

6.2.1  TWO-WAY RADIO MODES
Use the Radio settings section of ECH20 Utility to choose one of the following radio modes 
that support two-way communication. 

Two-Way 24-hour:  The radio logger listens for connection attempts every 45 s for 24 h 
a day. This mode uses a substantial amount of batter power. Expect batteries to last for 
approximately 3 months.

Two-Way 6:00-18:00:  The radio logger listens for connection attempts every 45 s between 
6 AM and 6 PM. The logger does not use the radio between 6 PM and 6 AM to conserve 
battery power, by not listening for connection attempts during the night. Expect batteries to 
last for approximately 6 months in this mode.

Transmit + two-way and CD Transmit + two-way:  These modes combine the two-way 
Radio modes and the Transmit Radio modes. You could use these modes while configuring 
and testing your radio network. You should not leave your radio logger in these modes 
because they use the most battery power of all the radio modes. Expect batteries to last for 
approximately 3 months in this mode.

NOTE:  Using Transmit + two-way and CD Transmit + two-way radio modes with the wake interval set to 1 or 2 can 
cause the batteries of your logger to drain very rapidly.

6.2.2  TWO-WAY BEST PRACTICES
Two-way modes is most useful when you have a small number (one, two, or three) of remote 
radio loggers you wish to contact. If you have three or more loggers installed within radio 
range of each other, consider using one of the Transmit modes. The two-way modes also 
allow you to mount an Rm-1 in your vehicle and interact with the remote logger while in radio 
range.

See section on Connecting via a Radio Modem for step by step instructions for establishing a 
two-way connection with a remote radio logger.

6.3  RADIO SETTINGS
For two radio devices to communicate they must share the same radio settings. An 
Rm-1 radio modem can only connect to a remote radio logger with the same radio settings. A 
DataStation only receives data from loggers with the same radio settings as the DataStation. 
Set the Radio Channel to the same value for all the devices on the same network. Set the 
Radio Subchannel to the same value for all the devices on the statement network.
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Radio logger networks with different values set for the Radio Channel use different 
frequency-hopping sequences, and therefore experience minimal interference between 
groups. Radio logger networks with the same Radio Channel value but different Radio 
subchannel values can interfere with each other, but cannot communicate with each other. 
This interference can also cause additional battery drain in the radio logger.

The default values for Radio Channel and Subchannel are zero. Use ECH20 Utility to choose 
other values.

6.4  RADIO PERFORMANCE
The maximum range of the radio modules in the radio logger and DataStation are affected 
by the environment, installation method, and antenna choice. Maximizing the range of your 
radio network requires you to consider these factors.

Buildings, hills, vegetation, vehicles, and other environmental obstructions sometimes 
shorten the radio range, sometimes drastically. You should ensure a clear, open path 
between radio devices. Also, radio frequency, or RF, interference in the environment around 
the radio can reduce the usable range (even if not using the same radio frequencies). You 
should consider nearby growing vegetation when designing and testing your radio network. 
Some radio networks work fine when the vegetation is sparse, yet may fail when vegetation 
is full.

You can increase the effective transmit range by maximizing the above ground height of the 
radio antenna. This helps ensure a clear path for the radio signals and reduces the amount of 
signal absorbed by the earth. Use an antenna extension cable to help position your antenna 
when it is not practical to install the logger higher off the ground. If you mount the radio 
logger to a metal pole, you should mount the antenna to the top of the metal pole so it is free 
to radiate the signal above the pole.

Replacing the stock antenna on your radio device with a high gain antenna can greatly 
increase the radio range. Consider using a directional Yagi antenna or a high-gain omni-
directional antenna when you want to extend the range of your radio network. A high-gain 
antenna can also help overcome the effects of unavoidable environmental obstructions.

The ECH2O telemetry system also supports a simple relay for use with Transmit Mode 
networks. Combining a relay and high-gain antennas allows radio devices to communicate 
over very long distances. Contact METER for more information on using a relay in your radio 
network.

6.5  CONNECTING VIA RM-1 RADIO MODEM
Connecting to an Em50R via a Rm-1 is different than connecting via your USB cable. Keep 
notes concerning the Em50R name and radio settings to make the rest of the system 
configuration easier to accomplish.
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Before you can use the telemetry options of your Em50R, you must configure the Em50R by 
connecting it directly to your computer using your USB cable. Connect using ECH20 Utility 
or DataTrac 3 and set the Em50R Channel, Subchannel, and Radio Mode. See the section 
on Configuring in ECH20 Utility for additional information on configuring the Em50 series 
loggers. The Channel can be set from 0 to 6 inclusive (default is 0). The Subchannel can be 
set from 0 to 65534 inclusive (default is 0). To use the radio logger with an Rm-1, the Radio 
Mode has to be set to one of the two-way modes.

If you choose the two-way 6:00-18:00 mode, then connection via the Rm-1 can only take 
place between the hours of 6:00 AM through 6:00 PM. We designed this mode was designed 
to improve battery life by not keeping the radio on constantly. The other two-way modes can 
be connected to 24 h a day.

After setting the Radio Mode, click the Apply button in ECH20 Utility. Disconnect from the 
Em50R logger. Now, connect your computer to the Rm-1 by using a standard 9-pin serial 
cable. (A USB version of the Rm-1 is also available.)

Choose the correct communication port in the Connect Via drop-down menu. For example, if 
your Rm-1 is physically connected to your computers COM1 communication port, you would 
choose "Rm-1 on COM1 Communication Port" in the Connect Via menu. Click the "Connect" 
button.

Figure 13  Logger Query Configuration

The Logger Query Configuration form appears. To connect to a specific Em50R, type the 
logger Name, Channel, and Subchannel. After typing the name, click the Query button. If you 
want to connect to any available Em50R, pick the correct Channel and Subchannel, but leave 
the Name field blank.

NOTE:  To connect to a radio logger, the radio Channel setting must be the same for both the logger and the Rm-1. The 
radio Subchannel setting must also be the same for both the logger and the Rm-1.
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The Connection Progress screen appears as ECH20 Utility tries to establish a radio 
connection with the remote logger through the Rm-1. The connection process can take up to 
60 s while ECH20 Utility sends a logger "wake up" signal and retries the connection attempt.

When ECH20 Utility connects to a remote radio logger, it shows the signal strength of the 
connection with the radio signal strength icon on the status bar. Click on the radio signal 
strength icon to see the signal strength percent in the message area. See Section 8 if 
ECH20 Utility fails to connect to your remote logger.

Once ECH20 Utility establishes a two-way radio connection with a remote logger, you can 
interact with the logger just like a direct connection.

You cannot change the radio Channel or radio Subchannel settings in the remote logger while 
connected via the Rm-1.

6.6  DATASTATION NETWORKS

6.6.1  CONFIGURE A DATASTATION
After establishing a connection, set the Channel and Subchannel. Set the Channel from 0 to 
6 inclusive (default is 0) and the Subchannel from 0 to 65534 inclusive (default is 0).
Notice the chosen Channel and Subchannel settings. Click the Apply button to save the 
settings to the DataStation. For easy data downloading and telemetry testing, leave the 
DataStation plugged into your computer and your powered at all times.

Configure an Em50R LoggerDataStation! Configuring Radio Logger for use with the 
DataStation To use one or more Em50R loggers with a DataStation the Radio Mode has to be 
set to one of the Transmit modes. We recommend the "Confirm Delivery" transmit mode.

Connect the Em50R to your computer or handheld device using the appropriate cable. 
Start ECH20 Utility, ECH20 Utility Mobile or DataTrac. Once you are connected, set the 
radio Channel and Subchannel settings to exactly the values chosen for the DataStation 
previously. Set the Radio Mode to Confirmed Delivery Transmit. This mode provides a method 
for confirming the delivery of the data which greatly increases the ability of the system 
to successfully transfer the data. The Transmit + two-way modes are there for use as 
troubleshooting aids. Set the measurement interval and pick the sensors that are plugged 
into each port. See the section on Configuring in ECH20 Utility for additional details on 
configuring the Em50 series. After setting the Radio Mode, click the Apply button.

NOTE:  ECH20 Utility only shows the radio modes compatible with your radio logger model and firmware version. If you 
do not see the "Confirmed Delivery Transmit" radio mode option, then your radio logger may not support this option. If 
you are using an Em50R logger you may need to update the firmware to version 1.12 or newer. Visit metergroup.com for 
the most current firmware and software modes.

http://www.metergroup.com
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6.6.2  COMMUNICATION TEST
Before finding a permanent location for your Em50R, perform a communication test to verify 
the quality of the radio communication. Make sure to properly configure and power the 
DataStation during your communication test.

In your field area, connect your Em50R to either a laptop or handheld device using the 
appropriate cable and press connect. Ensure that your radio channel, Subchannel, and 
transmit mode are the same as your DataStation. Choose "Communication Test" from the 
Actions menu (Figure 15).

Figure 14  Em50R Communication Test Window

Click the Test button and the test begins. When the test has finished it presents the results 
of the test. Five stars signifies excellent communication. One star means that all of your data 
is transmitting, but multiple tries are necessary. The more attempts to send data leads to 
more power consumption. One star is adequate for data transmission, but decreases battery 
life.

You may have to relocate the radio logger while doing the Telemetry Test in order to find the 
best connection quality. Once you have found the radio logger location that provides the best 
connection quality, install the radio logger at that location.

NOTE:  Communication Test only works with Em50 loggers running firmware 1.12 or newer.

6.7  DOWNLOAD COLLECTED DATA
After you configure the DataStation, it automatically collects data from those Em50R loggers 
that are within range and share the same Channel and Subchannel. After collecting data, 
you can retrieve it for permanent storage and analysis. DataTrac 3 is best suited for this 
application.
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To download and view data from the DataStation, start DataTrac. In the DataTrac 3 menu, 
pick the DataStation you want to connect to and click Connect. Click the Download New 
Data button. The Downloading DataStation Data screen appears and provides a progress bar 
displaying the download progress.

6.8  DATA PROCESSING
DataTrac 3 automatically sorts the data collected by the DataStation and associates the 
data with the correct logger. However, unless you used DataTrac 3 to also configure your 
Em50R loggers, DataTrac 3 does not know your logger name and which sensors are plugged 
into each port. To add this information to your data set, click on the appropriate Em50R in 
the logger tree and select "Configure."

If DataTrac 3 is not an option, you can use ECH20 Utility to retrieve data from your 
DataStation. ECH20 Utility gives you several choices for the file type when downloading data 
from a DataStation. Section 4 has more information on using ECH20 Utility for downloading 
data.

If you choose processed or raw data file formats, ECH20 Utility walks you through processing 
the data for each active logger. The ECH2O Utility prompts you for the logger type and sensor 
types for each logger. This information is necessary for ECH20 Utility to process the data 
correctly.
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7.  CARING FOR THE EM50

7.1  REPLACING THE BATTERIES
The Em50 requires little maintenance, if you install it correctly. The primary maintenance 
issue is that batteries must be replaced when their charge becomes too low. When the 
battery life indicator in ECH20 Utility shows your Em50 batteries are less than 5%, you need 
to replace them to continue logging and transmitting data. Use only NiMH (Nickel-Metal 
Hydride) batteries with the Em50/Em50G Solar loggers.

NOTE:  Installing or changing the batteries in your Em50 resets the internal real-time clock. You must connect to your 
Em50 using any ECH2O system software to reset the logger clock immediately after changing the batteries. Set the 
logger clock to ensure the recorded measurement time and date remain correct.

7.2  LONG-TERM MAINTENANCE
When caring for the Em50 over an extended period of time, be sure to check the logger 
periodically.
•	Check the battery holders and make sure they are clean and free of corrosion.

•	Check that the sensor ports are clean, and that the sensors are making good contact with 
the ports.

•	Check case gaskets and sensor cable strain relief.

•	Check or replace any zip ties securing the logger annually.

7.3  SENDING FEEDBACK TO METER
METER Software makes it easy to send feedback, bug reports, and feature requests to 
METER or your METER Distributor. Choose Send Feedback to METER from the help menu.
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Figure 15  Send Feedback to Decagon Window

In the Send Feedback to METER menu, enter your name, company name, and other contact 
information. Tell us what type of feedback you are sending (General Feedback, Feature 
Suggestions, Bug Report, or Other). Indicate how you want us to respond to your feedback 
(Email or Telephone).

Use the description area to give details for your feedback. If you are reporting a bug, it is very 
helpful for you to tell us what steps you took for the bug to happen and any error message 
you saw. By default, bug reports also include the software error files.

You can send METER a file using this form too. This is useful for sending data files that you 
have questions about. If you work directly with a METER representative, put their Email 
address in the field at the bottom of the form. This sends the contents of the form to them. 
Your METER representative can follow-up with you directly.
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8.  TROUBLESHOOTING
Although METER designed the EM60 for durability and built to the highest manufacturing 
standards, problems may occasionally occur. This troubleshooting section details the major 
problems and their solutions. If the problem is not listed or these solutions do not solve the 
issue, contact Customer Support.

Table 1  Troubleshooting EM60

Problem Possible Solutions

The ECH20 Utility tells me 
the communication port 
I want to use is in use by 
another application, but I do 
not think any other programs 
are running.

Some PDA synchronization programs monitor serial 
communication ports. Disable Microsoft's ActiveSync or Palm's 
HotSync system software while trying to use the serial port with 
the ECH20 Utility.

My USB to Serial adapter 
is not showing in the 
communication port picker.

Enable Force find all Communication Ports in the Preferences 
menu by going to the Edit menu, clicking Preferences, then the 
Communication tab, and enabling the check box at the bottom of 
the screen. Enabling this option may find other serial ports that are 
not available for use by the ECH20 Utility (for example, modems 
installed in your computer).

ECH20 Utility tells me it 
cannot connect to my device.

Try one or more of the following three suggestions to make sure 
there is a connection to the ECH2O device.

If you are using the accompanying USB cable, download the USB 
firmw from metergroup.com. Check your serial port choice. Make 
sure the Connect Via drop-down menu shows the name of the 
COM port you are using to physically connect to your logger or 
DataStation. For example, if our logger is physically connected to 
COM1, the Connect Via control should be set to Direct on COM1 
Communication Port or Direct on COM3 METER VCA

Check that your serial cable is securely plugged into your logger or 
DataStation and your Computer.

Make sure your logger has good Batteries! Replacingbatteries or 
your DataStation is plugged in. Try pressing the reset button on 
your logger or DataStation.
NOTE:  Serial and USB Cables can fail. If you suspect your cable may be the 
problem, try connecting to a second logger. If you can connect, the problem 
is probably the first logger. If you cannot connect to the second logger 
either, the problem may be your cable. Try using a spare METER Serial Cable 
Adapter or the USB cable if you are having trouble connecting to a logger.

ECH20 Utility keeps 
reporting it lost the 
connection to my device.

This rarely happens for a direct connection. Please check or 
replace your serial or USB cables. You can also increase the 
number of times ECH20 Utility tries sending commands to the 
logger or DataStation. Increase the Direct Connect Retries on the 
Communication tab of the Preferences form.

ECH20 Utility tells me 
my radio modem is not 
responding.

Make sure your serial cable is securely attached to your computer 
and your Rm-1. Your Rm-1 should have power and be turned on.

http://www.metergroup.com
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Table 2   Troubleshooting EM60 (continued)

Problem Possible Solutions

ECH20 Utility tells me it 
cannot connect to my radio 
logger when I use an Rm-1.

•	Try one or more of the following to make sure there is a good radio 
connection to your remote logger:

•	Make sure your DataStation and Em50R have the same Channel 
and Subchannel and that the DataStation is being continuously 
powered.

•	Make sure you are within radio range of the remote logger by 
performing a telemetry test. If this is the problem, increase the 
radio signal strength to your logger by moving closer to your 
logger or using a high-gain antenna to see if you can establish a 
radio connection.

•	Make sure the antenna on the logger and the Rm-1 are securely 
fastened to the radio module.

•	Check the Radio Channel and the Radio Subchannel settings you 
are using on your remote loggers and Rm-1. See Section 6 for how 
to configure your radio settings.

•	Make sure you wait 10 min between connection attempts for the 
same logger. If you just disconnected from a logger, you must wait 
for 10 min before that logger accepts radio connections (you can 
always direct connect to your logger).

•	Make sure your logger has good batteries. Try pressing the reset 
button on your logger.

ECH20 Utility keeps 
reporting it lost the 
connection to my device.

This can happen when the radio connection is lost. Try increasing 
the radio signal strength by moving closer to the remote logger or 
using a high-gain antenna. You can also increase the number of 
times ECH20 Utility tries sending commands to the logger. Increase 
the Radio Connect Retries in the Communications tab on the 
Preferences form.

ECH20 Utility tells me 
there is no new data for 
downloading.

Make sure the logger is configured to measure data. Make sure 
the measurement interval is set to a number greater than zero. 
Try pressing the reset button if the logger does have a non-zero 
measurement interval.

My sensor data shows "* * *" 
in the Scan window.

The three asterisks mean the raw data measured by the logger 
is out of expected range for the sensor. This could be caused by 
a broken sensor. Make sure the sensor is fully inserted into the 
logger sensor port. Make sure the sensor type shown in the Scan 
window matches the sensor actually connected to your logger.

My sensor data does not 
seem to be correct.

There are many issues that affect the quality of the sensor 
measurement. Please see the user manual of your particular 
sensor for help troubleshooting the data collected by your sensor 
or contact Customer Support.
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Table 2   Troubleshooting EM60 (continued)

Problem Possible Solutions

My logger stopped making 
measurements.

Make sure the measurement interval is not set to 0. The Em50 does 
not make any measurements when the measurement interval is set 
to zero.

Try pushing the reset button or initializing your Em50 if a reset is 
not enough to get the logger measuring sensors again. Connect to 
the logger and choose "Initialize Device..." from the Device Tools 
submenu in the Actions menu. Initializing your Em50 erases any 
stored data so you should download any data you want to keep 
before choosing this option.

My logger does not seem 
to be working correctly or 
reliably.

Try pressing the reset button on the logger. This resets the logger 
firmware. You can also try connecting to the logger and testing the 
integrity of the firmware. Choose Test Device Firmware from the 
Device Tools menu of the Actions menu. Contact METER for help 
reloading the firmware if ECH20 Utility reports the device firmware 
is corrupt. If the firmware tests good and your logger is still not 
working correctly, please contact METER for repair or replacement.
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8.1  CUSTOMER SUPPORT
Customer service representatives are available for questions, problems, or feedback Monday 
through Friday, 8 am–5 pm Pacific time. 

Email:	 support.environment@metergroup.com 
	 sales.environment@metergroup.com

Phone:	 +1.509.332.5600 

Fax:	 +1.509.332.5158

Website:	 metergroup.com

If contacting METER by email or fax, please include the following information: 

Name
Address
Phone

Email address
Instrument serial number
Description of the problem

NOTE:  For EM60 data loggers purchased through a distributor, please contact the distributor directly for assistance.

8.2  TERMS AND CONDITIONS
CONTRACT FORMATION. All requests for goods and/or services by METER Group, Inc. USA 
(METER) are subject to the customer’s acceptance of these Terms and Conditions. The 
Buyer will be deemed to have irrevocably accepted these Terms and Conditions of Sale 
upon the first to occur of the Buyer’s issuance of a purchase order or request for goods or 
services. Unless expressly assented to in writing by METER, terms and conditions different 
are expressly rejected. No course of dealing between the parties hereto shall be deemed to 
affect or to modify, amend or discharge any provisions of this agreement. 

PRICES AND PAYMENT. Invoice prices will be based upon METER prices as quoted or at 
METER list price in effect at the time an order is received by the Seller. Prices do not include 
any state or federal taxes, duties, fees, or charges now or hereafter enacted applicable to the 
goods or to this transaction, all of which are the responsibility of the Buyer. Unless otherwise 
specified on the invoice, all accounts are due and payable 30 days from the date of invoice. 
Unpaid accounts extending beyond 30 days will be subject to a service charge of 2% per 
month (24% per annum). Should Seller initiate any legal action or proceeding to collect on 
any unpaid invoice, Seller shall be entitled to recover from Buyer all costs and expenses 
incurred in connection therewith, including court costs and reasonable attorney’s fees. 

RISK OF LOSS AND DELIVERY TITLE. Liability for loss or damage passes to the Buyer when 
the Seller delivers the goods on the Seller’s dock or to the transporting agent, whichever 
occurs first. The Seller has the right to deliver the goods in installments. Shipping and 
delivery dates communicated by the Seller to the Buyer are approximate only.

mailto:support.environment%40metergroup.com?subject=
mailto:sales.environment%40metergroup.com?subject=
https://www.metergroup.com
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SHIPMENT. In the absence of specific shipping instructions, the Seller, if and as requested 
by the Buyer, will ship the goods by the method the Seller deems most advantageous. Where 
the Seller ships the goods, the Buyer will pay all transportation charges that are payable on 
delivery or, if transportation charges are prepaid by the Seller, the Buyer will reimburse the 
Seller upon receipt of an invoice from the Seller. The Buyer is obligated to obtain insurance 
against damage to the goods being shipped. Unless otherwise specified, the goods will be 
shipped in the standard Seller commercial packaging. When special packing is required or, in 
the opinion of the Seller, required under the circumstances, the cost of the special packaging 
shall be the responsibility of the Buyer.

INSPECTION AND ACCEPTANCE. Goods will be conclusively deemed accepted by the Buyer 
unless a written notice setting out the rejected goods and the reason for the rejection is 
sent by the Buyer to the Seller within 10 days of delivery of the goods. The Buyer will place 
rejected goods in safe storage at a reasonably accessible location for inspection by the 
Seller.

CUSTOM GOODS. There is no refund or return for custom or nonstandard goods. 

WARRANTIES. The Seller warrants all equipment manufactured by it to be free from defects 
in parts and labor for a period of one year from the date of shipment from factory. The liability 
of the Seller applies solely to repairing, replacing, or issuing credit (at the Seller’s sole 
discretion) for any equipment manufactured by the seller and returned by the Buyer during 
the warranty period. SELLER MAKES NO SEPARATE OR OTHER WARRANTY OF ANY NATURE 
WHATSOEVER, EXPRESS OR IMPLIED, INCLUDING THE WARRANTY OF MERCHANTABILITY 
OR FOR A PARTICULAR PURPOSE. There shall be no other obligations either expressed or 
implied.

LIMITATION OF LIABILITY. Seller will not be liable to the Buyer or any other person or entity 
for indirect special, incidental, consequential, punitive, or exemplary damages in connection 
with this transaction or any acts or omissions associated therewith or relating to the sale 
or use of any goods, whether such claim is based on breach of warranty, contract, tort, or 
other legal theory and regardless of the causes of such loss or damages or whether any other 
remedy provided herein fails. In no event will the Seller’s total liability under this contract 
exceed an amount equal to the total amount paid for the goods purchased hereunder.

WAIVER. In the event of any default under or breach of the contract by the Buyer, the Seller 
has the right to refuse to make further shipments. The Seller’s failure to enforce at any time 
or for any period of time the provisions of this contract will not constitute a waiver of such 
provisions or the right of the Seller to enforce each and every provision.

GOVERNING LAW. The validity, construction, and performance of the contract and the 
transactions to which it relates will be governed by the laws of the United States of America. 
All actions, claims, or legal proceedings in any way pertaining to this contract will be 
commenced and maintained in the courts of Whitman County, State of Washington, and the 
parties hereto each agree to submit themselves to the jurisdiction of such court.
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SEVERABILITY. If any of the Terms and Conditions set out in this contact are declared 
to be invalid by a court, agency, commission, or other entity having jurisdiction over the 
interpretation and enforcement of this contract, the applications of such provisions to 
parties or circumstances other than those as to which it is held invalid or unenforceable 
will not be affected. Each term not so declared invalid or unenforceable will be valid and 
enforced to the fullest extent permitted by law and the rights and obligations of the parties 
will be construed and enforced as though a valid commercially reasonable term consistent 
with the undertaking of the parties under the order has been substituted in place of the 
invalid provision.

SET-OFF. The Buyer may not set-off any amount owing from the Seller to the Buyer against 
any amount payable by the Buyer to the Seller whether or not related to this contract.
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APPENDIx A. COMPLIANCE CERTIFICATIONS
This appendix contains compliance statements that apply to the Em50 and Em50G.

A.1  EM50 CE COMPLIANCE
Application of Council Directive: 		  2004/108/EC and 2011/65/EU

Standards to which conformity is declared:	  EN 61326-1:2013 and EN 50581:2012

Manufacturer’s Name: 			 METER Group, Inc. USA 
2365 NE Hopkins Ct.  
Pullman, WA 99163 
USA

Type of Equipment: 			 Data collection system

Model Number: 			 Em50

Year of First Manufacture: 		 2002

This is to certify that the Em50, manufactured by METER Group, Inc. USA, a corporation 
based in Pullman, Washington, USA meets or exceeds the standards for CE compliance as 
per the Council Directives noted above. All instruments are built at the factory at METER and 
pertinent testing documentation is freely available for verification.

A.2  EM50R/DATASTATION/RM-1 CE COMPLIANCE
Application of Council Directive: 		  89/336/EEC

Standards to which conformity is declared:	 EN61326 : 1998 and EN55022 : 1998

Manufacturer’s Name: 			 METER Group, Inc. USA 
2365 NE Hopkins Ct.  
Pullman, WA 99163 
USA

Type of Equipment: 			 Data collection system

Model Number: 			 Em50R 2.4 GHz, Rm-1 2.4GHz, and  
DataStation 2.4 GHz

Year of First Manufacture: 		 2002

Restrictions:
France: Current regulations in France stipulate that these devices may be used indoors 
only. Outdoor use on private property is subject to authorization from the French 
Telecommunications Regulatory Authority. Outdoor use on public property is currently 
prohibited. For more information, see ero.dk.
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A.3  FCC COMPLIANCE
The following FCC statement applies to the Em50, Em50R, Em50G, DataStation, and Rm-1. 
This device complies with part 15 of the FCC Rules. Operation is subject to the following 
conditions:

1.	 This device may not cause harmful interference.

2.	 This device must accept any interference received, including interference that may 
cause undesired operation.

The Em50R, DataStation, and Rm-1 contain one of the following modules:
•	FCC ID: OUR9XSTREAM IC: 4214A-9XSTREAM

•	FCC ID: OUR-24XSTREAM IC: 4214A 12008

The Em50G contains the following module:
•	FCC ID: IHDT56HQ1 IC: 109O-HQ1

Information for users:
Changes or modifications to the EM50 series loggers not expressly approved by METER 
Group, Inc. USA could void FCC compliance and thus the user’s authority to operate the 
equipment.

This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference in a residential installation. This equipment 
generates, uses and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio communications.

There is no guarantee that a particular installation. If this equipment does cause harmful 
interference to radio or television reception, which can be determined by turning the 
equipment off and on, we encourage users to attempt to correct the interference by trying 
one or more of the following measures.
•	Reorient or relocate the receiving antenna.

•	Increase the separation between the equipment and receiver.

•	Connect the equipment into an outlet on a circuit different from that to which the receiver 
is connected.

•	Consult METER Customer Support or your local representative for support.
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A.4  EM50G CE COMPLIANCE
Application of Council Directive: 		  2004/108/EC

Standards to which conformity is declared:	 EN61326-1:2013 and 2011/65/EU

Manufacturer’s Name: 			 METER Group, Inc. USA 
2365 NE Hopkins Ct.  
Pullman, WA 99163 
USA

Type of Equipment: 			 Data collection system

Model Number: 			 Em50G

Year of First Manufacture: 		 2010

Cellular Module Information
The Quad-band GSM/GPRS cellular module in the Em50G has been tested and approved 
under the standards and regulations listed below:
• FCC part 12,22,24. FCC ID: IHDT56HQ1

• Industry Canada (IC) 109O-HQ1

• R&TTE - LVD 2006/95/EC Standards: EN301 489-1 & 7, EN60950

• EU Product Approval Number: G24-L

• GCF 3.27.1

• NAPRD 3.14.0

• PTCRB
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